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Introduction and Welcome
Welcome to ZagNet, Gonzaga’s student network. As a user of ZagNet, you have high-speed
access to campus computing resources, the Internet, electronic mail, and the World-Wide Web.
You also have a technical support team to assist you with using ZagNet should you encounter
problems. ZagNet alleviates the need to use a modem to dial into the library or check your e-mail.
You can now do that from the convenience of your computer without tying up your phone line.

What Comes with ZagNet?

ZagNet is the student network and support system. It includes network access to your residence
hall, software for your computer, and technical support staff should you encounter problems. It
also includes academic resources such as access to the library, Encyclopedia Britannica Online,
and academic software on Barney, Gonzaga’s academic server. You also receive an e-mail account
that you retain your entire time at Gonzaga, a server to place your personal web page on, and
Usenet, a global discussion network consisting of more than 10,000 discussion groups.

Where to Begin?

There are a couple of steps you should take to prepare to use ZagNet.

• Purchase and install a network card for your computer*
• Install the ZagNet software on your computer*
• Sign the Acceptable Use Policy**
• Pickup your e-mail account**

*Assistance in installation of the network card and installation of the ZagNet software is
available during the first part of the semester Connection Central in the Crosby Center. For more
information, contact the Help Desk at x5550.

**Signing the Acceptable Use Policy and picking up your e-mail account can be done at the
orientation days at the beginning of school and in AD016 during the rest of the year between
10:00AM and 11:00AM. Extended hours are available the first two weeks of each semester.

Once you have your network card and ZagNet software installed, go through this manual to
configure individual programs included with ZagNet. These include Internet Explorer 5.0,
Outlook Express 5.0, QvtNet (PC) or NCSA Telnet (Mac), and Fetch 3.0 (Mac).

If You Need Assistance

If you require assistance with connecting to the network or using the included ZagNet software,
contact the Help Desk at x5550 from 8:00AM to 4:30PM Monday-Friday.
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ZagNet Support Services
Help Desk Information - x5550

As a part of ZagNet, Gonzaga University has a technical Help Desk. Students, faculty, and

employees are able to call a single telephone number and receive help in solving computer related

problems. Students who are having problems connecting to ZagNet can call the Help Desk staff,

who will help them diagnose and solve basic network-related problems. If the problem can’t be

quickly resolved, and appears to be network-related, the Help Desk staff will initiate a work

order and transmit it to desktop support staff who will work with the student to resolve the

problem. In addition, the Help Desk staff track all unfinished work orders to ensure they are

resolved. Students who are experiencing problems connecting their computers to ZagNet or the

Internet, or using any of the supported applications, can send e-mail to helpdesk@gonzaga.edu

or call x5550 to talk to a Help Desk staff member.

Supported Applications

ZagNet provides students with access to a broad range of electronic resources. Students are able

to create their own web pages, electronically submit assignments, search the World-Wide Web for

research and other materials, run academic software applications, communicate with others both

on and off campus, and access scholarly research materials and electronic journals, all from the

comfort and convenience of their rooms. Available resources include student e-mail, the World-

Wide Web, academic software, LIBRIS - the Foley Center online library catalog, Encyclopedia

Britannica Online, the Project MUSE electronic research journal collection, Bell and Howell s

Proquest, and other Internet resources.

As a part of this network access, Gonzaga will provide students with limited support for

computer and network software. Students who need help connecting to the ZagNet network and

the Internet, or who have questions about using Internet Explorer, Outlook Express, QvtNet,

NCSA Telnet, or Pine, should call the Help Desk at x5550 to receive help.

The university support staff will not be able to provide support for other hardware issues or

software applications. For other software and hardware issues, students should call the vendor s

support line for assistance.

Further Information

This manual is intended to provide a basic introduction to ZagNet services and applications.

More extensive information is available in the electronic manuals for the applications and on

Barney s web site at http://barney.gonzaga.edu.

mailto:helpdesk@gonzaga.edu
http://barney.gonzaga.edu
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Using the World-Wide Web
What is the World-Wide Web?

The World-Wide Web (the Web) is composed of hundreds of thousands of independent web

servers containing millions of web pages that are loosely linked together. These web servers are

owned and operated by companies, schools, organizations, the government, and individuals.

There are nearly a dozen university operated web servers at Gonzaga alone. Because of the

distributed nature of the Web and the Internet, the reliability of individual web servers may vary.

What may be accessible one day may be down the next. Such is the nature of the Internet.

The Web contains information on almost every topic. Since the content of the Web is created by

many individuals, many diverse opinions exist on the Web. Content is often governed by a policy

at the location where the web server is located. This is the case with Gonzaga; any information

that is placed on a web server at Gonzaga (whether university owned or private) is governed by

Gonzaga s Acceptable Use Policy.

Using Internet Explorer 5 for Web Browsing

The most difficult part of using Internet Explorer as a web browser is understanding how the

World-Wide Web works. By understanding the basics of how to access documents on the Web,

you are well on your way to utilizing the most common features of Explorer.

Understanding URLs

URLs (Universal Resource Locators) are the addresses of the Web. URLs are used to describe the

location of web pages on the Internet. Using a URL, you can locate any web page on the Internet.

The structure of a URL is fairly simple: it consists of a protocol identifier, a server address, and a

web page name. For example, the URL http://www.gonzaga.edu/zagnet/index.html specifies

the hypertext transfer protocol (http), the www.gonzaga.edu web server, and the web page

named /zagnet/index.html (/zagnet/ is the path to the file) on the www.gonzaga.edu web server.

There is typically a default web page on each web site that alleviates the need to specify a web

page name unless you want to go to a specific page on that web server. For example, the URL

http://www.gonzaga.edu will automatically load the default web page on the www.gonzaga.edu

server.

Since a URL is the unique address to a web page, to go back to a web page in the future, the only

thing you have to remember is the URL. Explorer will use the URL to locate the web page and

reload all of the data for that web page. By keeping a list of URLs, you can easily return to pages

you have visited before. You can also send a person a URL via e-mail and the other person can

use the URL in their copy of Explorer or any other web browser and load the same page you

saw.
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Loading a Web Page using a URL

If you have the URL for a web page, you can easily go to that web page using Explorer. To load a

web page using a URL, do the following:

1. Launch Internet Explorer.

2. Select Open...  from the File menu.

3. Enter the URL to open and click OK.

Explorer will attempt to contact the web server where the web page described by the URL is

located. If the web server is busy, unavailable or doesn t exist, Explorer will report an error. If

this happens verify that you entered the URL correctly and try again or wait and try again later.

Links

One of the most powerful features of the World-Wide Web

(and the reason that it s called a web) is the ability for one

web page to link to another web page. A link is created by

embedding a URL within a web page. These links  to other

pages are normally indicated on the web page as underlined

colored text (typically blue). By clicking on the link, Internet

Explorer will attempt to locate the server for the link s URL and load the new web page. This is

just as if you had manually entered the URL in the Open dialog box.

These links are not limited to linking to other web pages. They can also refer to an e-mail address,

a file to be downloaded, an audio or video clip, etc. These are all special forms of URLs that help

make the World-Wide Web a rich environment. For example, the Downloads web page on Barney

(http://barney.gonzaga.edu/tech/download.html) is a list of links that will download files from

Barney through anonymous FTP if they are clicked on.

Bookmarks

There are millions of web pages on the World-Wide Web.

Among those, you will find a number of pages that you

want to return to later. Rather than write down the URL

and manually enter it each time you want to go to that

web page, you can create a bookmark for that page. A

bookmark remembers the URL and the title of the page

and stores this information in a bookmark file. These

bookmarks are available under the Favorites menu.

http://barney.gonzaga.edu/tech/download.html
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To add a web page to your bookmarks, do the following:

1. Go to the web page you wish to bookmark.

2. Select Add to Favorites  from the Favorites menu.

Once you ve added a bookmark to your Favorites menu, all

you need to do to go to the web page you ve bookmarked

is to select the bookmark from the Favorites menu.

After you have accumulated a large number of bookmarks, you may find that the Favorites menu

gets cluttered. You can clean up the Favorites menu by selecting Organize Favorites  from

the Favorites menu. This will open a window that will allow you to delete old bookmarks and

arrange bookmarks into folders (folders show up as sub-menus within the Favorites menu).

Finding Information on the World-Wide Web

As mentioned earlier, the World-Wide Web contains millions of web pages that are constantly

changing. Because of this, locating information could be difficult. Fortunately, there are a number

of search engines  on the World-Wide Web that make it easy to search the Internet. These

search engines are constantly searching the Web for new or changed web servers and pages. The

information they find is added to

their databases which are indexed

for easy and fast searching.

Using any of these search engines,

you can do a keyword search that

will effectively search millions of

web pages in just a few seconds.

The search engine returns a list of

links that match your search

criteria. The better the search

criteria you enter, the better the

search results. For example,

searching for Word help  would

return many thousands of hits but

searching for Microsoft Word

printing problem  makes the

search more specific.
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Here are some search engines you may find useful:

http://www.altavista.com http://www.go.com

http://www.yahoo.com http://www.lycos.com

Yahoo (http://www.yahoo.com) has an extensive list of search engines on their web site. To find

the list, go to Yahoo and search for search engines.

Finding E-Mail Addresses on the Web

While there is no master directory of e-mail addresses on the Web, many organizations maintain

online e-mail directories for their employees and for universities, their students. Gonzaga

provides such a directory at http://barney.gonzaga.edu/email. This page also has links to several

sites that search the Internet for e-mail addresses and add them to their databases similar to how

web search engines build their databases.

If you are looking for the

e-mail address of a specific

person, you can see if the

company they work at or

the school they attend has

an online directory like

Gonzaga s. You can also

search one of the national

e-mail directories for their

name and e-mail address or

you can even search one of

the web search engines like

Alta Vista or Yahoo for

their name.

For More Information on
Internet Explorer

Internet Explorer and the

World-Wide Web have

many features that cannot

be included in such a short

introduction. For information on these features, use Explorer s built-in help system. To access

help, use the Help  menu inside of Internet Explorer.

http://www.altavista.com
http://www.yahoo.com
http://www.go.com
http://www.lycos.com
http://barney.gonzaga.edu/email
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Configuring Outlook Express 5.0
Requesting an E-Mail Account

It is recommend that you already have your e-mail account before configuring Outlook Express.

Accounts are available both Saturday and Monday of Fall orientation weekend on the 2nd floor

of the Crosby Student Center. During the rest of the year, they are available in AD016 during

normal working hours.

What is Outlook Express 5.0?

Outlook Express 5.0 provides e-mail, Usenet news, and directory service access. It can compose

messages in html and plain text formats, has an integrated spell checker, and a powerful address

book. The next three chapters will cover the configuration and use of Outlook Express. This

chapter will go through the configuration, the next will discuss reading and composing mail, and

the final chapter will discuss reading Usenet news using Outlook Express.

It is highly recommended that you use Outlook Express 5.0 or later. The ZagNet installation

process will install Outlook Express 5.01 for Windows or Outlook Express 5.02 for Macintosh.

These later versions have much better support for IMAP and have more extensive features than

earlier versions.

POP or IMAP Mail Protocol

Gonzaga’s student mail server, Barney, supports two types of mail protocols, POP (aka POP3)

and IMAP. When you configure Outlook Express, you will need to select either POP or IMAP.

This won’t effect how your mail is sent or looks, but it will change where it is stored. You can

always change your mind and switch the protocol you want to use later.

The primary difference between POP and IMAP is that POP downloads all your messages from

the mail server to your local hard drive and then deletes them from the mail server. IMAP keeps

the mail on the server and downloads only those messages you click on to read.

POP s primary advantage is that all of your messages are downloaded at once. It can also be

configured to periodically check the mail server for new mail. Since it connects only periodically,

any mail that has already been downloaded to your local computer can be read even if the

network is down or the mail server is offline. The disadvantage of POP is that once the messages

are downloaded to your local hard drive, you can t read the downloaded mail from another

computer (e.g., another room or from a computer lab). This disadvantage can be diminished by

turning on the Leave messages on server  option but this means that you re keeping two copies

of every message; not very economical.
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IMAP is a newer protocol that was designed with the premise that the client computer (you) are

always connected to the network and that the mail server is always available. It keeps all of the

messages on the mail server and only downloads the header information for the mail messages

(subject, sender, recipient, and length). When the user clicks on a message, IMAP downloads the

rest of the message from the mail server for display but doesn t delete it from the server. IMAP

also allows you to utilize mail folders on the server for filing messages. These folders are

compatible with Pine so that all of your mail is available not only from Outlook Express, but

from Pine and through the web (coming January 2001) as well. This is advantageous if you want

to be able to read and file mail from other computers besides your own, including computers off-

campus. The disadvantage of IMAP is that it is slightly slower than POP because it must retrieve

messages from the mail server rather than from your local hard drive.

POP is recommended for those users that are going to primarily read their e-mail from one

computer. It is also recommended for those users that have older computers. IMAP is

recommended for those users that want full access to their e-mail regardless of the computer they

are using.  More information on IMAP and POP can be found at http://www.imap.org.

A Note Regarding Outlook Express 5.02 for Macintosh

The following configuration guide deals primarily with the configuration of Outlook Express for

Windows. The Macintosh client offers similar functionality but the layout of the windows and

the configuration options are slightly different. The following instructions should be sufficient to

configure the Macintosh client as well.

Configuring Outlook Express 5.0

The configuration for Outlook Express is easiest when using the Internet Connection Wizard.

The wizard runs automatically when Outlook Express is launched for the first time. After the

initial account is created, a new account can be added by selecting Accounts  from the Tools

menu in Outlook Express and then clicking on the Add  button in the Internet Accounts

window that appears and selecting Mail.  You can also modify the settings for your account

by opening the same Internet Accounts window.

The information you will be entering includes your e-mail address and name, various server

addresses, and other details. Multiple users can use the same computer by creating multiple

Identities.  This manual does not include instructions on setting up identities or other advanced

options. Refer to the Help menu in Outlook Express for information on additional configuration

options.

http://www.imap.org
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Configuring E-Mail

To configure Outlook Express, do the following:

1. Launch Outlook Express.

You may receive a warning that Outlook Express is not your default mail client. If you are

only using Outlook Express on this computer, you will probably want to make it the default

mail client.

2. Enter your name and then click the Next>  button.

If Outlook Express launches directly to its main window, at least one account has already

been created. A ZagNet technician or someone else may have already created the account for

you or Outlook Express might have been installed and configured prior to your arrival at

Gonzaga. You can see whether you already have the account configured by selecting

Accounts  from the Tools  menu, clicking on the Mail  tab, and examining the list of mail

accounts. If you already have one setup then, you can probably ignore the remaining steps.

If you aren t sure, create a new account by selecting Accounts  from the Tools  menu,

clicking on Add  button in the Internet Accounts windows, and selecting Mail .

3. Enter your e-mail address and click Next>.

Note: If you don t have an e-mail address yet, you will not be able to proceed further with

the configuration of Outlook Express.

4. Select your preferred method for downloading e-mail

from Barney.

Note: IMAP is recommended unless you will only be

reading mail from this computer.

5. Enter barney.gonzaga.edu  as the incoming and

outgoing mail server and then click Next>.

6. Enter your mail server username and then click Next>.  This is your login name on Barney

(e.g., francis or msmith7).

Warning: At this point, you can elect to enter and save your password. If you choose to do

this, anyone that has access your computer will be able to read and send e-mail as you.
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7. Click Finish  to save your mail account settings.

If this is your first account in Outlook Express, you will be given the option to import

information from other mail clients. Unless you have information you want to import, simply

click Next>  and then Finish  to skip importing information from other mail clients.

8. If you selected IMAP as your mail server type in step 4 above, do the following steps. If

you selected POP3, skip to step 9.

a. Click No  when asked if you want to download a list of folders.

b. Select Accounts  from the Tools menu.

c. Double-click on the barney.gonzaga.edu  mail account.

d. Click on the IMAP  tab.

e. Uncheck Check for new messages in all folders.

f. If you want to save your sent mail on Barney, check

Store special folders on IMAP server  and enter

sentmail  as your Sent Items folder and drafts  as

your Drafts folder.

Note: The good thing about keeping your outgoing mail in a folder on Barney is that it

will be accessible from anywhere. The downside is that it will take longer to send

messages and it will count toward your 40MB disk limit on Barney.

g. Click OK  to save your settings.

h. Click Close  to close the Internet Accounts window.

i. When asked if you want to refresh your folder list, click Yes.

j. Enter your password and click OK.

Note: If you have requested your account, but it hasn t been created yet, you will receive

an error that you could not connect to your account on Barney.

Configuring Usenet News

9. Select Accounts  from the Tools menu.
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10. Click on the Add  button and select News .

11. Verify your name and click Next>.

12. Verify your e-mail address and click Next>.

13. Enter news.gonzaga.edu  as your news server and

click Next>.

14. Click Finish.

Configuring Gonzaga White Pages (Directory Services)

15. Click the Add  button and select Directory Service .

16. Enter whitepages.gonzaga.edu  as the LDAP server and click Next>.

17. Click on Next>  to skip auto-checking of addresses.

18. Click Finish.

19. Double-click on whitepages.gonzaga.edu  to make

additional changes.

20. Change the descriptive name to Gonzaga White Pages.

21. Click on the Advanced  tab.

22. Set the Search Base to o=Gonzaga University, c=US .

23. Click OK  to save the changes.

24. Click Close  to close the Internet Accounts window.

Note: You will now be asked if you want to download the current list of newsgroups. If you

choose to do so, you will also be given the opportunity to subscribe to newsgroups.

At this point, you have configured Outlook Express to read and send electronic mail, access

Gonzaga s Usenet news server, and to be able to query Gonzaga s directory service to lookup

e-mail addresses for people at Gonzaga. To learn how to use these services, go to the appropriate

chapters in this manual or use Outlook Express  help system.
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Using Electronic Mail (Outlook Express)
Electronic mail, more commonly referred to as e-mail, is one of the oldest and most popular uses

of the Internet. Gonzaga s electronic mail system allows you to communicate with other

students, faculty, and staff on campus and anyone that is connected to the Internet, either

directly or through an online service such as America Online. Electronic mail has historically been

the most popular network service at Gonzaga.

Students are provided a number of e-mail clients to choose from. The two supported clients are

Outlook Express and Pine. Pine is a text-based mail program on Barney accessed using telnet and

is described in the section Using Electronic Mail (Pine).  Outlook Express is a free graphical

client available from Microsoft for both the Macintosh and Windows that also includes a Usenet

client and other capabilities.

This document will provide some basic information regarding e-mail and will also provide

information on using Outlook Express to read and compose e-mail.

Your E-Mail Address

Everyone at Gonzaga has the option of getting an account on Barney. For those that are using

these accounts for e-mail, their e-mail address is userid@gonzaga.edu where userid  is your

account name. For example, if my name was Jane Doe and my userid (account) was jdoe, my e-

mail address would be jdoe@gonzaga.edu. Students using other servers would put the server

name and domain after the @.  As an example, if Jane were on the Grace server in Computer

Science, her address would be jdoe@cps.gonzaga.edu. Most students will use Barney as their e-

mail server so their address will end with @gonzaga.edu.

Locating an E-mail Address for Someone at Gonzaga

It is often desirable to locate another person s e-

mail address to send them mail. Gonzaga has a

search engine on the Web and on Barney to look

for someone s e-mail address based on either

their first or last name. The web-based search is

at http://barney.gonzaga.edu/email.

If you telnet into Barney, you can type mailid

keyword , replacing keyword with a portion of

the person s name (e.g., mailid jane  would list

all of the Janes at Gonzaga).

http://barney.gonzaga.edu/email
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Gonzaga also has something called the Gonzaga White Pages.  These white pages can be

searched from either Outlook Express or from within Pine.

To search the white pages from within Outlook Express, do the following:

1. Click on the Addresses  icon in the main Outlook Express menu.

The Address Book window will appear.

2. Click on Find People  icon in the Address Book window.

3. Select Gonzaga White Pages  from the Look

in  popup menu.

Note: If Gonzaga White Pages  isn t listed,

go to the section titled Configuring Outlook

Express 5.0  to add the directory (step 15).

3. Enter part of the name of the person you want to search for in the Names  field. For a more

advanced search click on the Advanced  tab.

Note: Students that have requested confidentiality will not appear in the e-mail directory. If

you are on the directory and would like to be removed, contact Greg Francis at x6896 or

francis@gonzaga.edu.

4. Right-click on the person you would like to send mail and select Send Mail  from the Action

sub-menu. A dash in place of their e-mail address indicates the person doesn t have a known

e-mail address.

Checking and Reading Mail in Outlook Express (POP3)

When using POP3, your mail must be downloaded from Barney to your local computer before it

can be read. Once it is on your local computer, it can be read, replied to, filed, and/or deleted. All

mail folders are stored on your local hard drive. All new mail is downloaded from Barney into

your Inbox folder.

You can either have Outlook Express check mail for you automatically (see Options under the

Tools menu) or you can force it to check for mail by clicking on the Send/Recv  in the main

window. Outlook Express must be running on your computer in order for it to automatically

download mail.

mailto:francis@gonzaga.edu
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If you have new mail on Barney, Outlook

Express will download all of the mail to your

local computer. If the messages are long or

contain file attachments, this may take a few

moments. The status bar at the bottom of the

main window will indicate how many read

messages you have..

To read the mail in your Inbox, do the following:

1. Launch Outlook Express.

2. Click on the Inbox  in your folder list.

3. If you check mail manually, click the Send/Recv  button to download your new mail.

4. Click on the message that you want to read. The text of the message will appear below.

5. Once you ve read the message, you can delete it by clicking on the Delete  icon at the top of

your Inbox window or you can file it into another folder by clicking on the File  icon.

Note: It is recommended that you either delete the mail from your Inbox or file it to another

mailbox if you want to keep it for later use. This keeps your Inbox uncluttered and will help

it respond quicker, especially on older computers.

Creating Folders for Storing Mail (POP3)

You can create additional folders to file your mail in so it doesn t clutter your Inbox. This is

useful because it also allows you to group all the mail for one topic or person into a single

location. To create a folder, do the following:

1. Right-click on Local Folders  and select New Folder .

2. Enter the name of the new folder and click OK.

The folder will now be listed in your folder list under Local Folders. To save messages into

this folder, just drag the message from its current folder to the new folder.
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Checking and Reading Mail in Outlook Express (IMAP)

When using IMAP, portions of your mail will reside on the remote server (Barney) and portions

can reside on your local drive. This allows you the maximum flexibility when using Outlook

Express but it can also be somewhat confusing as well.

Reading and filing mail with IMAP is nearly

identical to using POP3 with the exception that

IMAP adds an additional folder set to your folder

list. This folder is called barney.gonzaga.edu.  It

contains your Inbox on Barney and any mail

folders you have on Barney as well. Any folder in

here is also going to be accessible from Pine.

Folders that reside in Local Folders  are on your

local hard drive and cannot be accessed by Pine.

To read your mail, follow the same steps as you

would for reading POP3 mail above but open up

the Inbox in barney.gonzaga.edu  instead of the one in Local Folders.  The same applies for

creating mail folders and filing mail. You can create mail folders either on Barney or your local

drive. If you want it to be available from Pine, create the folder in barney.gonzaga.edu.

Composing New Mail

Outlook Express makes it easy to compose new e-mail messages. It includes an address book

feature, the ability to easily attach files to messages, and also the ability to copy text from a word

processor directly into an e-mail message.

To create a new message, do the following:

1. Launch Outlook Express.

2. Click the New Mail  icon or select Mail

Message  from the New  sub-menu of the

File menu.

An empty message window will appear.

3. Enter the recipient s address in the To:

field. To enter multiple addresses, just

press the Enter key; Outlook Express will

add additional lines as needed.
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If you don t know the person s address and they are at Gonzaga, you can select Address

Book  from the Tools menu to search Gonzaga s White Pages. See the instructions earlier

in this chapter for more information.

4. Enter the subject of the message in the Subject:  field.

5. Click in the body of the message and either type the message or copy and paste the message

from another program.

6. If you wish to attach a file to the message, do the following:

a. Click on the Attach  icon at the top of the message window.

b. Locate the file you want to attach, highlight it and click Attach.

7. Click on the Send  button in the message window to send the message.

Creating a Signature

A signature is a block of text that is appended to the end of new messages. A signature is usually

used to provide information about the person sending the message. People often include e-mail

addresses, phone numbers, employer, titles, and cute little quotes in their signature. To create a

signature in Outlook Express, do the following:

1. Select Options  from the Tools menu.

2. Click on the Signatures  tab in the Options window.

3. Click on the New  button to create a new signature.

4. Enter the text of the signature in the Edit Signature

block at the bottom of the window.

6. To include your signature on all outgoing mail, check the

Add signatures to all outgoing messages  checkbox.

7. Click OK  to save your new signature.

For More Information

Outlook Express includes many additional features that you may find useful. To learn more

about these features, use Outlook Express  help system available under the Help  menu.
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Using Usenet News
What is Usenet?

Usenet is a network of thousands of servers on the Internet that house thousands of discussion

groups called newsgroups. Each server can be configured to carry a select number of the

newsgroups or all of the newsgroups. These news  servers periodically connect with one

another to pass along any new articles that were created on its server or that were passed to it by

another news server. Because of this distributed architecture, an article posted on Usenet may

take several days to be distributed to all of the news servers that carry the newsgroup where the

article was posted.

Gonzaga s news server carries approximately 10,000 of the most commonly read newsgroups of

the more than 35,000 newsgroups on Usenet. Most of the other newsgroups are either regional,

for companies, or for a very specific group. Requests for adding a newsgroup that Gonzaga

doesn t carry can be sent to Greg Francis at francis@gonzaga.edu. As an example, the Seattle

newsgroups were added at the request of someone from the Seattle area.  Newsgroups designated

for the posting of files such as music or images will not be carried because of the excessive disk

space required to store the files.

What is a Newsgroup?

A newsgroup is a discussion area on Usenet that was created for the posting of a specific topic.

Topics can be anything; examples include artificial intelligence, the show Friends, politics, and

skydiving. Many of these newsgroups are purely for entertainment while others can yield

valuable information for research projects. One thing to remember about newsgroups is that

anyone can post to them; this means all information on Usenet should be questioned and verified.

In addition to the Usenet newsgroups, there is a set of newsgroups that are local to Gonzaga.

Each of these newsgroups begin with gu.  to indicate it is local to Gonzaga. Anything posted in

one of these groups is not distributed outside of the university. Topics for the Gonzaga

newsgroups include announcements, events, and the sale of textbooks and other items. Clubs and

other campus organizations can request a newsgroup of their own by contacting Greg Francis at

francis@gonzaga.edu.

To make finding newsgroups easier, newsgroups are given names that group them into categories

and subcategories. For example rec.skydiving means the subject of skydiving in the recreation

category. Newsgroup names can get fairly complex; for example rec.arts.sf.tv.babylon5.info is

for information on the science fiction television show Babylon 5. Fortunately, newsgroup names

are searchable making it much easier to locate topics of interest.

mailto:francis@gonzaga.edu
mailto:francis@gonzaga.edu
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A Note about Usenet Etiquette

Since articles posted to Usenet are distributed to thousands of news servers around the world and

can be read by millions of people, it s important that users understand how to post correctly and

that they understand proper Usenet etiquette. Before posting, you should look at the articles in

news.announce.newusers and news.answers. One particularly good article is A Primer on How
to Work With the Usenet Community by Chuq Von Rospach. This article is posted frequently in

both news.announce.newusers and news.answers; it is also located on Barney s web site at

http://barney.gonzaga.edu/tech/usenetcommunity.html.

Breaking the rules of Usenet can result in a lot of hostile mail (called flames) from other users on

Usenet. Using Usenet can be fun and informative but it s important to be knowledgeable about

posting and be prepared to have your opinions blasted by others that disagree with you.

Using Outlook Express to Read Usenet News

Outlook Express is capable of connecting to a Usenet news server and downloading articles to

read. The following instructions assume that you have already set up the news server

(news.gonzaga.edu) when configuring Outlook Express in Chapter 5 of this manual. Another

newsreader called tin  is available if you telnet into Barney.

To read articles in Usenet news, do the following:

1. Open Outlook Express.

2. Click on news.gonzaga.edu  in the folder list.

3. Expand the newsgroup list by clicking on the

minus sign next to news.gonzaga.edu on the PC

or the small triangle on a Mac.

4. To read the articles in a newsgroup, click on the

name of the newsgroup you want to read.

Note: If you aren t currently subscribed to any newsgroups, Outlook Express will ask you if

you want to download a list of newsgroups.

Outlook Express will download the articles for the newsgroup you clicked on. The window

will be divided into two panes, the top pane will list all the articles in the newsgroup and the

bottom pane will show the text of the currently selected article. Unread articles will be bold

text and previously read articles will be plain text.

5. To read an article, click on the article subject.

http://barney.gonzaga.edu/tech/usenetcommunity.html
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Note: Articles with the same title are grouped

into a thread  to make it easier to follow the

discussion. Threads are indicated by a plus

sign (PC) or a triangle (Mac). A thread can be

expanded or contracted by simply clicking on

the appropriate symbol.

6. To reply or post a response to the current

article, select the appropriate reply type from

the Message  menu.

Your response can be sent back to the original

poster, to the newsgroup itself, or both.

Once you ve completed your message/article, send it by clicking on the Send  button.

7. If you want to post a new article, click on the New Post  button.

Subscribing to Newsgroups

You can read the articles within a newsgroup whether you are subscribed to the newsgroup or

not; subscribing to a newsgroup just makes the newsgroup easier to access. Subscribing to a

newsgroup tells Outlook Express to list the newsgroup in your folder list and to keep track of

which articles you ve read. It does not mean that you will receive mail from the newsgroup nor

does it inform anyone else that you are subscribed to the newsgroup. You can subscribe or

unsubscribe to a newsgroup at any time.

To subscribe to a newsgroup:

1. Launch Outlook Express.

2. Click on news.gonzaga.edu  in the folder list.

3. Click on the Newsgroups  button in the

right pane.

A Newsgroup Subscriptions  window appears that lists all the newsgroups on the current

news server (in this case, news.gonzaga.edu).

4. You can either enter a filter in the Display newsgroup that contain  box or you can scroll

through the list to select a newsgroup.

5. Click on the newsgroup(s) you want to subscribe to and click subscribe.



Page 20 Using Usenet News

6. Once you are done subscribing to newsgroups, click the OK  button.

While there are many thousands of groups, there is not one for every topic imaginable so you

may not be able to find the topic you are interested in. If that s the case, you might look for a

more general topic newsgroup that would be appropriate for the discussion of the topic you have

in mind.

Unsubscribing from Newsgroups

If you are no longer interested in reading a particular newsgroup, you can easily unsubscribe from

it. To unsubscribe from a newsgroup, simply click on the newsgroup name in the folder list,

right-click and select Unsubscribe  from the pop-up menu. This will remove the newsgroup

from your folder list and delete any information about the newsgroup from Outlook Express.

Dealing with High Volume Newsgroups

When you re reading a newsgroup, there will often be messages that you don t read. This is

especially true on high volume groups that can receive hundreds of new articles a day. To reduce

the clutter of a high volume newsgroup, you can mark all the articles as read and then only view

unread articles. This will reduce the total number of articles listed, making it much easier to

browse through.

To hide read articles, do the following:

1. Open the newsgroup and read the articles you are interested in.

2. When you are done reading articles, Mark All Read  from the Edit menu.

3. Next time you open the newsgroup for reading, select Hide Read Messages  from the

Current View sub-menu of the View menu.

This will hide all the previously read articles.

A Note about Usenet and Spam

Because of Usenet s distributed nature, it is a prime target for spammers to post their spam on

and to harvest  e-mail addresses to mail spam to. Every time you post an article on Usenet,

your e-mail address is being distributed all over the world to thousands of servers. Spammers

collect the e-mail addresses of Usenet posters and add them to their spamming lists. We attempt

to block spam coming into Gonzaga, but posting to Usenet will increase the likelihood that you

will receive spam messages.
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Using Telnet
Telnet is a method of connecting to a server and accessing the server s resources remotely.

Access is usually text-based and requires some knowledge of the system you are connecting to.

At Gonzaga, Barney and Grace can all be accessed using telnet. In order to use the applications

on Barney or Grace, you must use telnet. Barney e-mail is available through telnet (Pine), POP,

and IMAP (both Outlook Express).

The ZagNet software includes a telnet client for you to use. Students with PCs will use QvtNet

and Macintosh users will use NCSA Telnet. Configuration of the software is different on the two

platforms but once you are connected to a server (e.g., Barney), the commands are all the same

since the commands are being executed on the remote server, not the local machine.

A Typical Telnet Session

A telnet session begins by connecting to remote server, logging into the server, executing

commands on the server and then logging out of the server. The following is the list of steps

required to log into Barney that will work with any telnet client. The specific commands required

for individual telnet clients will vary from client to client.

To connect:

1. Launch the telnet client.

2. Open a new session.

3. Enter the name of the server you want to connect to (e.g., barney.gonzaga.edu) and begin the

session.

4. Log into the remote server using your account (Barney or Grace).

Once you are connected, you will typically have a command line on which to type commands.

These commands are then executed on the remote server. Any files, messages, etc. you see are on

the remote server, not your computer.

To disconnect:

1. Normally you will type a command to disconnect from the system. On Unix systems such as

Barney and Grace use the command exit.  Other systems may use different commands such

as logout  or quit.

2. Quit the telnet client.
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Using Telnet Clients Included with ZagNet

QvtNet (Windows)

The following are instructions for using QvtNet to telnet.

To open a connection to Barney or Libris (Library):

1. Launch terminal  in Start—>QvtNet.

2. Select Open  from the File menu to bring up the Open Session  window.

3. Type barney  or foley  and then click OK.

To open a connection to any other remote server:

1. Launch terminal  in Start—>QvtNet.

2. Select Open  from the File menu to

bring up the Open Session  window.

3. Type the remote server you want to

connect to and click OK.

NCSA Telnet (Macintosh)

NCSA Telnet comes preconfigured for accessing Barney and Libris (Library) and does not require

any additional configuration. Opening a connection to Barney and Libris are as easy as selecting a

menu item.

To open a connection to Barney or Libris (Library):

1. Launch NCSA Telnet.

2. Select the remote server from Open Special  under the File menu.

To open a connection to any other remote server:

1. Launch NCSA Telnet

2. Select Open Connection...  from the File menu.

3. Type the remote server you want to connect to and click Connect.



Using Electronic Mail (Pine) Page 23

Using Electronic Mail (Pine)
General Information

Pine is an e-mail program located on Barney and is accessible through any telnet application that

supports VT100 terminal emulation or better. The primary benefit of Pine over other e-mail

programs is that it is accessible from anywhere on the Internet. Whether you are in Spokane,

Florence, or at home, if you have Internet access, you can get to Pine.

Pine help is context-sensitive. In other words, each Pine screen you use will have its own help

text, explaining the choices available for that screen. Pressing the ?  key (^G when composing)

will display the help screen for the screen you are currently viewing in Pine. The bottom two

lines of the screen are used to list the commands currently available. If there are more commands

available than will fit on a screen, the O  key will page through the list of available commands.

When composing mail, and in a few other places in Pine, you have to use control keys. Control

keys are entered by pressing the <CTRL>  key and the appropriate letter key at the same time.

In Pine, control key commands are shown as a ^  followed by a letter key. For example, ^X

would mean that you need to press the <CTRL>  key and the X  key simultaneously.

Electronic Mail Addresses

Each user on the Internet has a unique address. This address is composed of the user s account

followed by an @  and then the server where the account is located. For example, if a user had

an account of horatio  on a server known to the Internet as iea.com,  their address would be

horatio@iea.com.  The user s account does not have to correspond to the user s name.

Most users at Gonzaga have an Internet address of username@gonzaga.edu.   For students, the

account is usually their first initial followed by the first seven characters of their last name. For

faculty, the first eight characters of their last name are used for their account. This will depend

upon whether or not there are people with similar names. When addressing mail to someone at

gonzaga.edu,  only the account name is required.

Gonzaga provides several ways to look up student and employee e-mail addresses. User s can

search the web at http://barney.gonzaga.edu/email, type mailid  followed by a person s name

while at the $ prompt in Barney, or search the Gonzaga White Pages through Pine (see below).

Entering and Exiting Pine

To run Pine, simply enter the command pine  at the [username]$ prompt. This will take you

to Pine s main menu. From there, you can press I  to go into your INBOX folder.

http://barney.gonzaga.edu/email
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Typing Q  from most places in Pine will exit Pine and return you to the [username]$  prompt.

Pressing ^Z  in Pine will temporarily suspend Pine. Typing fg  at the [username]$  prompt

will resume a suspended Pine session. This is useful for users that often use the unix command

line for programming, viewing files, and other tasks.

Reading Your E-Mail

The INBOX message index is your mailbox in

Pine. This is where any new mail will appear.

Any mail you have read will remain here until

you either file it to another folder or delete it. A

+  in the first column of the message index

means that the message marked is addressed

specifically to you. If no +   is shown, you are

not the primary recipient of the message. The

two most common reasons for receiving a

message not addressed specifically to you is if the message is from a mailing list you are a

member of or if the message was CC d (carbon copied) to you.

Choose the message you wish to read by highlighting it using the up or down arrow keys. Once

the appropriate message is selected, press the >  or <ENTER>  key to view the message. To

scroll through the message, you may use the arrow keys, or the -  key for the previous page and

the space bar for next page of a long message.

While you are either reading the message, or while you have the message highlighted in the index,

you may press R  to reply to the message, F  to forward the message, or D  to delete the

message. Messages marked for deletion will not be purged until you exit Pine. You may undelete

a message that hasn t been purged yet by pressing the U  key. If you do not delete the message,

or move it to another folder, it will remain in your INBOX folder.

To return to the index of mail, press I . Pressing P  will move you to the previous message and

N  will move you to the next message in your INBOX.

Creating/Using Folders

Pine gives you the opportunity to create folders to store your messages in other than the INBOX

folder. To create a folder, press L  to list your folders. At this point, a new screen will appear

with the word Mail  highlighted. Pressing the <ENTER>  key will list on the folders in your

Barney account. If you wish to add a new folder, press A  for Add. Pine will ask you the

Folder name to add:.  Type in the name for the folder and press <ENTER>.  You will see the

name of the new folder added to your expanded folder list.
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You may save a message to a folder either while you are reading the message, or while you have

the message highlighted in the message index. In either of these situations, press S  to save. You

will then be prompted with a message similar to:  SAVE to folder in Mail [postmaster]: . Type

the name of the folder you wish to save the message in and press <ENTER>.  Your message will

be moved to the new folder and marked for deletion in the current folder.

You can switch between folders by

pressing L  and then <ENTER>  to get

the list of folders, then using the arrow

keys to select the folder you want to

open, and then pressing Enter  again to

open the selected folder.

Folders are an excellent way to store e-

mail messages for later use and are highly

recommended for those that want to keep

their e-mail messages after reading them.

Sending E-Mail

To send an e-mail message, type C  to compose. You will be prompted for the primary

recipient s address (To:), other recipients  addresses (Cc:), files to attach (Attchmnt:), and the

message subject (Subject:). Any of these may be left blank, except the To: field. After scrolling

through the top options with the <ENTER>  key or the down arrow, you will see the cursor

resting in the Message Text  area. It is in this area which you enter your message.

When you are ready to send the message, simply press ^X  (Control-X) to Send. You will then

be prompted with Send Message?   At this point you will either type in Y  for Yes or N  for

No. N  will take you back to the message editing area. If you wish to cancel the message without

sending it, press ^C  for Cancel at the message editing area.

When the cursor is at the To: or Cc: field,

you can search either your address book or

the Gonzaga White Pages by pressing ^T.

After pressing ^T,  select whether you

want to search your address book or the

white pages and then enter the first or last

name of the person you are looking for. You

select the address you wish to send to by

hilighting the person s name and pressing

<ENTER>.  Note that people are listed

even if they don t have an e-mail address.
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Creating a Signature File

A signature file is a text file whose contents will automatically be appended to the end of

outgoing messages. It typically contains information such as your name, e-mail address and

organizational affiliation. Pine adds the signature into the message as soon as you enter the

composer so you can choose to remove it on a message by message basis. For example:

*********************************************************
Mickey Mouse, Ph.D
President, Walt Disney University
1-800-PIP-SQUK
MOUSE@DISNEY.COM
*********************************************************

To create a signature file, press M  to go to the main menu, then S  to select a configuration

option, and finally S  to edit your signature. When you are done editing your signature, press

^X  to exit the editor and Y  to save your changes. You may also create a .signature  file in

your home directory using a text editor such as pico, vi, or emacs. This text file is the same as

creating the signature directly in Pine.

Attachments

You may attach a file to your e-mail message. To do this, the file must be located in your home

directory on Barney. At the Attchmnt:  prompt in your message editing area, simply type the

name of the file located in your home directory. If you have created a sub-directory in which the

file is stored, you must include the name of this directory in your filename. Once you have

entered the name of the file, you may complete your message and send it to the recipient. You

may attach more than one file to a message. You may also browse files in your home directory by

pressing ^T  while the cursor is at the Attchmnt:.

There may be times when you receive an attachment that Pine cannot read. Because Pine is a text

based system, it is not able to display many types of attachments such Word and WordPerfect

documents, spreadsheets, graphics, and html documents. These documents must first be saved in

your home directory and then transferred to a computer (typically a PC or a Mac) that is capable

of viewing that type of file.

To save an attachment from a message you ve received, open the message, press >  to view the

attachments, select the attachment to save using the arrow keys, and then press S  to save the

attachment. Pine will often provide a default file name. If not, you can enter any filename you

want and then press <ENTER>  to save the attachment as a file in your home directory. You

can now transfer the file to a PC or Mac using an FTP application. For more information on

FTP, see the document Transferring Files To and From Barney (FTP). This document is also

available in the ZagNet Manual.
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Using the Pine Address Book

Pine s address book allows you to keep a list of addresses you send mail to so you do not have

to remember addresses that are often complex. Each entry in the address book has three required

fields which are:

Nickname: A short, easy-to-remember label to identify the entry. This is what you type in as

you are addressing the message in the composer. If there is a matching entry in your

address book(s), Pine will extract the corresponding FullName and Address fields to

generate the actual address for your message.

Fullname: A longer field where you can put the full name of the person or organization.

Whatever you put as the name here will appear on the message when it is finally

delivered.

Address: The actual e-mail address(es).

To add an alias to your address book,

press M  to go to the main menu and then

A  to update your address book. Press

the @  key to add an alias to the address

book. You will be prompted for the three

required elements above. Once these

elements are entered, the alias is available

for your use. Simply enter the alias in the

To: field of your message composer area.

You may also easily create a distribution list. Each distribution list has a nickname, a full name,

and a list of addresses. The addresses may be actual addresses or they may be other nicknames in

your address book. They may even refer to other distribution lists. A distribution list is created

the same way as an address for a single person; the only difference is that you enter multiple

addresses on the Addresses:  line by separating each address with a comma.

Printing Your Messages

To print an e-mail message, you must first let Pine know where you would like the message to

print. Type help printing  at the [username]$  prompt to find the appropriate command.

At the Main Menu in Pine, type S  for Setup. Once in Setup, choose P  for Printer. You will

then be given three options. At this point enter arrow down to the Personally selected print

command  option and press <ENTER> . When asked Command for custom printer:  enter the

information which you retrieved from the help printing  area in Unix. This printer will then be

used each time you print, unless you choose another printer.
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Downloading Files using FTP
Transferring files to and from Barney or other server is done using the File Transfer Protocol,

more commonly referred to as FTP. Using FTP, you can transfer files to and from Barney

regardless of whether you are using a PC, a Mac, a UNIX server halfway around the world, or

any other type of computer that supports FTP.

How FTP Works

FTP works by having an FTP client log into an FTP server. Barney is configured as both an FTP

client and server so you can both log into and out of Barney using FTP. Personal computers are

typically only an FTP client. FTP clients can only log into FTP servers, no one can log into an

FTP client. This is done to keep others from logging into a computer without authorization and

transferring files to or from that computer. FTP servers must be configured with accounts and

passwords to ensure sufficient security.

When logging into an FTP server, an FTP client must enter an account and password. Many FTP

servers are configured with an account called anonymous.  This account allows a user to login

and download files from the server even though they don t have an account on the FTP server.

This is commonly used on servers that archive software such as shareware and public domain

software and are commonly known as Anonymous FTP Sites.  Barney allows anonymous

logins for downloading software used for ZagNet.

Once an FTP client has logged into an FTP server, the user is able to view file directories,

download and upload files to the server, and even delete files if they have proper authorization.

Logging into an FTP Server

How you log into an FTP server will depend on whether you are using a command line interface

such as UNIX or a graphical interface such as Mac or Windows. From UNIX (e.g., Barney) or

other command line interface, you would type ftp server_name (e.g., ftp barney.gonzaga.edu)

to log into the specified server. If a successful connection occurs, you will be prompted for your

username and password. If you are connecting with an anonymous FTP site, type anonymous
for the username and your e-mail address as the password. If you have entered a valid username

and password, you will then have a prompt from which to enter commands.

Graphical FTP Clients

Graphical user interface (GUI) operating systems

such as Mac and Windows normally don t require

you to enter commands directly. Regardless of the

FTP client software you use on a GUI computer,
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you must first open a connection and then enter a username and password. Once you have logged

in, you will typically be able to browse files and directories just as you would on your local hard

drive. Many of the following instructions have little relevance to GUI users since they typically

don t need to enter commands directly. Some FTP client software for GUI computers (e.g.,

WinQVT for Windows) does require the entering of commands.

Listing Files and Directories

When you are connected to an FTP server, you can view a listing of files on that server by

entering the command ls or dir. This will list all of the files and directories in the current

directory. If you FTP into Barney, the current directory starts as your home directory. Here is a

typically listing from ls:

   -rw-r--r--   1 francis  cis        21103 Aug  6 13:28 ANSYS52
   drwx------   2 francis  cis         1024 Aug 12 08:40 Mail
   drwxr-xr-x   2 francis  cis         1024 May 31 08:17 bin
   -rw-r--r--   1 francis  cis           27 May 29 15:11 forward
   drwxr-xr-x   2 francis  cis         1024 Aug  2 17:56 manpgasc
   drwxr-xr-x  10 francis  cis         2048 Aug  5 15:39 public_html
   -rw-r--r--   1 francis  cis       153238 Jul 10 16:27 unx_staff.lis
   -rw-r--r--   1 francis  cis       458473 Jul 10 16:27 unx_students.lis

Those lines that begin with a d  indicate directories (e.g., Mail  and bin  above) and those

that begin with a -  are files (e.g., forward  above). The number near the center of each listing

(e.g., 153238  for unx_staff.lis ) is the size of the file in bytes. Finally, the name of the file or

directory is at the far right of the listing (e.g., public_html ).

If there are a great deal of files in the current directory, you can limit the listing to a select group

of files by setting criteria for the ls command. For example, ls a* would list only those files that

begin with the lowercase letter a.

To list files in your local directory (i.e., where you are FTPing from), the command will vary

depending on which FTP client you are using. Common ones include lls (local listing), ldir (local

directory), and !ls -l (the ! executes a command on your local computer). If none of these work,

check help while at the FTP>  prompt for a list of available commands.

Changing to a Different Directory

Quite frequently, you will want to transfer files to or from a directory that is not the default

directory you logged into. To change to a different directory, you will use the cd command. For

example, to change to the public_html  directory in the listing above, you would type cd
public_html. Type cd .. to go to the parent directory of the current directory. Another option is

to enter an absolute path name such as cd /home/staff/cis/francis. Following are some examples

of changing the current directory:
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   cd manpgasc Changes to the manpgasc directory in the current directory

   cd .. Changes to the parent directory of the current directory

   cd /home/staff/cis/francis Changes to the directory /home/staff/cis/francis

Once you have changed to the new directory, use the ls command will list the files in the new

directory.

As with listing files in a local directory, the commands for changing directories also varies

depending upon the FTP client you are using. The two most common options are lcd and !cd.

Consult help in FTP for the specific command in your FTP client.

ASCII and Binary Files

Files can either be stored as ASCII or binary files. ASCII files are typically text files created by

text-based editors such as Notepad, SimpleText, vi or pico. ASCII files contain only 7-bits of

data per character while binary files are composed of 8-bit characters. Types of binary files

include applications, word processor documents, graphic files, and most other types of files.

Most documents generated on a PC or a Mac are binary files.

A special type of Macintosh file is MacBinary; this is a binary file that preserves Macintosh

specific information for the file including the type of document and the application that created

it. When transferring files from a Macintosh for use on a different type of computer, transfer files

using plain binary rather than MacBinary.

When transferring files with FTP, you need to set whether to transfer the file as ASCII or binary.

If you are unsure which method to use, transfer the file using binary mode. ASCII mode should

typically be used for text files and files ending with .uu  or .hqx.  To set ASCII mode, type

ascii while connected to an FTP server. For binary mode, type binary. To determine which

mode you are in, type type.

Transferring Files

Once you have connected to the remote FTP server, logged in with a valid user name and

password, set the appropriate local and remote directories, and set the correct transfer mode

(ASCII or binary), you are ready to transfer files. To transfer files to the FTP server from where

you logged in from, use the send command. To transfer files from the FTP server to where you

logged in, use the recv command. Using either send or recv, you specify the name of the file you

want to transfer. For example, to send a file named sample  from the local computer to the FTP

server, you would type send sample. Some FTP clients allow you to use wildcards such as *

to transfer many files at once, others do not.

Depending on the size of the file being transferred, the time needed to transfer the file can take a

second to several hours. Gonzaga s Internet connection is sufficient to transfer most files in
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under five minutes unless the file is very large. If transferring files between two computers on

GUnet (Gonzaga s network) or ZagNet (Gonzaga student network), the transfer time will be

even shorter. If transferring files over a modem, transfer times can be several hours for large files.

If you need to transfer additional files to or from the same FTP server, change the directories and

file types as needed and then transfer the files. There is no limit to the number of times that the

directory and file type can be changed in a single session.

If desired, a file transfer can usually be canceled by pressing Control-C.

Disconnecting from an FTP Server

When you have completed transferring files to or from the FTP server, you will need to

disconnect. For command line users, this is done using the command quit. GUI users will

normally have a button or menu option to close the connection.

For Additional Help

When you are connected to an FTP server, you can enter the command help for a list of

commands. Typing help command (e.g., help recv) will usually provide some additional

information on that specific command. While logged into a UNIX server such as Barney, you can

enter man ftp at the command prompt ( [username]$  on Barney), for detailed information on

the use of FTP.
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FTP COMMANDS - QUICK SUMMARY

! [command] Available in some FTP clients. Used to invoke a command that is normally only

available from the command prompt. For example, !ls invokes the ls command on the

local computer to list files in the current directory.

append local [remote] Appends the contents of the local file to the end of the remote file.

ascii Set ASCII transfer mode. Used for text, HQX, and uuencoded files.

binary Set binary transfer mode. Used for graphics, programs, and most other files other than

those listed under ascii.

bye Close the connection to the FTP server and exit. Same as quit.

cd [remote-directory] Set the current remote directory to the specified directory.

close Disconnect from the FTP server but don t exit the FTP software.

delete remote-file Deletes the specified remote file if user has required permissions.

dir [remote-directory] List the contents of the specified remote directory. If no directory is specified, list the

contents of the current remote working directory. Same as ls.

help [command] Displays information concerning the specified command. If no command is specified,

help lists the available commands.

lcd [local-directory] Available in some FTP clients. Change the current local directory to the directory

specified.

ls [remote-directory] Same as dir.

open ftp-server Open a connection to the specified FTP server. FTP must already be running and no

connection currently established.

pwd Display the name of the current working directory.

quit Disconnect from the FTP server and exit the FTP software.

recv remote-file Copy the specified remote file to the local working directory using the current transfer

mode (binary or ASCII).

send local-file Send the specified local file to the remote working directory using the current transfer

mode (binary or ASCII).

size remote-file Display the size of the remote file.

status Show the current status of the FTP client.

user user-name Log into an already open FTP server as the specified user.
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Text Editors on Barney (pico, vi, emacs)
Text editors are programs used to edit text files. Text files are limited to letters and numbers only;

they do not include graphics, fonts, or special formatting information found in documents created

by word processors. Text files include mail messages, source code, batch files, and configuration

files. Text files are the most common type of file you will use on Barney. For this reason, there

are several options available to you when you are working with text files.

Text Editors Available on Barney

There are three text editors that are available on Barney. These are pico, vi, and emacs. Each can

be run by typing their name at the [username]$  prompt. For extensive help on each of these

editors, type man editor  at the [username]$  prompt. In addition, both pico and emacs have

help systems available while they are running.

Each of these text editors is significantly different from the other. Pico is a simple editor with

basic functions such as cut and paste, searching, and spell checking. Pico was written by the

same group that wrote the e-mail software, pine, so there are a great deal of similarities between

the editor in pine and pico. Within pico, commands are listed at the bottom of the screen.

Because of its ease of use and similarity to pine, pico is the default editor on Barney. Programs

such as tin (Threaded Internet News) use pico whenever an editor is needed. Pico is suggested

for those users that need some simple text editing without the complexity of vi or emacs.

Vi is a more sophisticated and complicated editor than pico. It has more powerful searching

capabilities, can replace blocks of text, jump to line numbers, and a host of other features. Its

power comes primarily from its ability to move to precise locations within a file using very few

keystrokes. This makes it an excellent editor for configuration files and source code. In addition,

vi comes preinstalled on most UNIX systems. This makes moving from one UNIX system to

another easier.

Emacs is the most powerful of the three editors. It has customized environments for writing

source code in various languages, allows split screens, custom commands, and more. For those

users that are going to do a lot of programming or working with large text documents in UNIX,

emacs can save a lot of time once the initial learning curve is completed. Its sophistication is

matched by its complexity.

The remainder of this document will focus on the vi editor. Users interested in pico or emacs
should refer to their respective man pages, their online help, or other resources.

Vi is a screen-oriented editor. That means that the entire screen is used when editing a file. In

order for vi to work correctly, you must be using terminal emulation that supports moving

around the screen. VT100 and VT220 are common emulations that support screen editing.
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Vi is run by either typing vi  or vi filename  at the [username]$  prompt. If no filename is

specified, vi opens a new document. The ~  characters in an empty file are used to indicate

empty lines in the file.

Command and Input Modes

Vi operates in two different modes -- command and input. The input mode is used while

inserting text into the file. Some commands are available in input mode, but most are only

available in command mode. Command mode is used for moving around the file, deleting or

inserting blocks of text, and saving the file. In addition, command mode can be used to execute

shell commands such as ls and more.

The ESC (escape) character is used to enter command mode from input mode. ESC can also be

used within command mode to cancel a command that has been partially entered. Input mode is

entered by (i)nserting or (a)ppending text.

When entering a command in command mode, entering a number before the command will cause

the command to repeat that number of times. For example, entering ^B  scrolls the file back one

screen and entering 5  then ^B  would scroll the screen back five screens. Note: the ^

indicates that the CTRL (control) is held down while pressing the letter.

Moving Around Within a File

As stated previously, one of the greatest strengths of vi is its ability to move around within a text

file using a minimum of keystrokes. You may move by character, word, sentence, paragraph, and

page. Following are some commands that can be used to move around within a file. These

commands only apply while in command mode.

Scrolling Line/Character Movement
^B Scroll backward one screen h Move backward one character

^F Scroll forward one screen j Move down one line in same column

^U Scroll backward a half screen k Move up one line in the same column

^D Scroll forward a half screen spc Move one right one character

^Y Scroll backward one line - Move to first real character in previous line

^E Scroll forward one line ^ Move to first real character in current line

+ Move to first real character in the next line

Context Movement $ Move to the end of the current line

W Move forward to beginning of a word 0 Move to the first character of the current line

B Move backward to beginning of a word G Goto line number (if # entered) or end of file

( Move to the beginning of a sentence*

) Move to the end of a sentence* Movement by Search
{ Move to beginning of prev paragraph / Search forward for text following /

} Move to beginning of next paragraph ? Search backward for text following ?

*A sentence is defined as a period, !, or ? followed by two spaces or a new line.
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Remember, you can cause the above commands to repeat multiple times simply by entering a

number before you type the command. This is especially useful with the G  command, as it will

allow you to jump to a specific line anywhere in the file (e.g., 100G  jumps to line 100).

Entering and Editing Text

Vi offers several ways to insert and change text. You can insert text beginning at the current

character, after the current character, at beginning or end of the current line, or insert a new line

above or below the current line. You can also replace existing characters, blocks of characters, and

lines. Commands are entered in command mode unless stated otherwise. Remember, many of

these commands can be preceded with a number to indicate the number of times (or count) the

command should be performed.

Inserting Text* Changing Text
i Insert before current character r char Replace current character with character
a Insert after current character R text ESC Replace current character(s) with text
I Insert at beginning of current line s text ESC Substitute current character with text
A Append to end of current line S text ESC Substitute entire line with text
O Insert new line above current line cw text ESC Change current word to text
o Insert new line below current C text ESC Change rest of current line to text
ESC Return to command mode J Join next line(s) to end of current line

Deleting Text Copying and Placing Text
x Delete current character(s) nyy Yank (cut) n lines and place in buffer

X Delete previous character(s) p Put yanked text after cursor

dw Delete current word(s) P Put yanked text before cursor

db Delete previous word(s)

dd Delete line(s) Undo
:n,md Delete lines n through m u Undo last command

D Delete from cursor to end of line U Restore current line to original state

*Entering a command to insert or append text will leave you in insert mode until you press the ESC key.

You can also search and replace text strings using a command in the form, :n,ms/str1/str2/opt.
This command will search from lines n to m for the string str1. If it finds str1, it will replace it

with str2 depending upon the option used. Options include g  for global, c  for confirm, and p

for print changes. For example, if I wanted to search lines 100 to 200 for the string tony  and

replace it with toni  with a confirmation of the change for each instance, I would use the

command :100,200s/tony/toni/c.

Saving and Quitting vi

When quitting vi, there are several options for saving or throwing away changes to the document.

:wq Write to current file and quit :q Quit (must save first)

:w Write to current file without quitting :q! Quit without saving changes

:w file Write to new file without quitting :e! Re-edit current file, discarding unsaved changes

:w! Write to file, ignoring read-only status
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WARNING: UNIX does not maintain multiple versions of a file like VAX systems do. Unless

you specifically write to a different file, you are modifying the original file. Once the changes

have been written to the file, there is no way to recover the previous contents of the file.

VI COMMAND QUICK REFERENCE

Running vi Getting More Help
vi Runs vi and starts a new file man vi Displays the man page for vi editor

vi file Runs vi and opens file man ex Displays the man page for ex (line oriented editor)

Scrolling Line/Character Movement
^B Scroll backward one screen h Move backward one character

^F Scroll forward one screen j Move down one line in same column

^U Scroll backward a half screen k Move up one line in the same column

^D Scroll forward a half screen spc Move one right one character

^Y Scroll backward one line - Move to first real character in previous line

^E Scroll forward one line ^ Move to first real character in current line

+ Move to first real character in the next line

Context Movement $ Move to the end of the current line

W Move forward to beginning of a word 0 Move to the first character of the current line

B Move backward to beginning of a word G Goto line number (if # entered) or end of file

( Move to the beginning of a sentence

) Move to the end of a sentence Movement by Search
{ Move to beginning of prev paragraph / Search forward for text following /

} Move to beginning of next paragraph ? Search backward for text following ?

Inserting Text* Changing Text
i Insert before current character r char Replace current character with character
a Insert after current character R text ESC Replace current character(s) with text
I Insert at beginning of current line s text ESC Substitute current character with text
A Append to end of current line S text ESC Substitute entire line with text
O Insert new line above current line cw text ESC Change current word to text
o Insert new line below current C text ESC Change rest of current line to text
ESC Return to command mode J Join next line(s) to end of current line

Deleting Text Copying and Placing Text
x Delete current character(s) nyy Yank (cut) n lines and place in buffer

X Delete previous character(s) p Put yanked text after cursor

dw Delete current word(s) P Put yanked text before cursor

db Delete previous word(s)

dd Delete line(s) Undo
:n,md Delete lines n through m u Undo last command

D Delete from cursor to end of line U Restore current line to original state

Writing Files Quitting and Resetting vi
:wq Write to current file and quit :q Quit (must save first)

:w Write to current file without quitting :q! Quit without saving changes

:w file Write to new file without quitting :e! Re-edit current file, discarding unsaved changes

:w! Write to file, ignoring read-only status

*Inserting commands will remain in insert mode until the ESC key is pressed.
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Student Web Pages on Barney
Introduction

The academic server (Barney) is available for hosting student created web pages. Web pages

located on Barney can be accessed by anyone using a browser on the World-Wide Web. These

pages might be used for personal information, student projects, entertainment, resumes, or any

other information you may wish to provide that you would like others to see.

Restrictions

Anyone that has an account on Barney may have a web page including students, clubs, and

employees of Gonzaga. The creation and display of web pages are governed by Gonzaga

University s Acceptable Use Policy. The disk space consumed by web pages counts against the

total disk space allotment your account is allocated on Barney. The amount of disk space your

account is using is displayed each time you telnet into your account.

Location of Web Files on Barney

The web server on Barney cannot access any of the files or directories in your account other than

the directory public_html  located in your root directory. The public_html directory can only

be accessed by the web server if the access permissions are set correctly. This prevents others

from accessing files in your account without your permission. When your account is setup on

Barney, the public_html directory is automatically created for you with the correct permissions.

The file index.html  is the default web page within the public_html directory (or any sub-

directory within public_html). This is the web document that will be opened if no specific file is

specified in the URL. For example, http://barney.gonzaga.edu/~jdoe will display the index.html

file in jdoe s public_html directory while http://barney.gonzaga.edu/~jdoe/resume.html will

display the resume.html file in jdoe s public_html directory. It s always a good idea to have an

index.html in your public_html directory so people have a starting web page for your account.

File and Directory Permissions

By default, Barney makes any file you create readable and writeable only by you. This is to

protect your files from being accessed by others unless you specifically give them permission to

read the files. In order for a web page to be readable by the web server, the file and the directory

it is in must have public read permissions. When using FTP to transfer files to Barney, Barney

will automatically create the file with global read privileges so that you don t have to change

these privileges manually.
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To make a file readable by everyone, type chmod 644 filename  at the $ prompt, replacing

filename with the actual name of the file to set. To make a directory readable by everyone, type

chmod 755 directoryname  at the $ prompt. Type man chmod  for more information regarding

the chmod command.

Transferring Files to Barney

HTML documents may be created directly on Barney or may be created on a different computer

and then uploaded to Barney. Files can be uploaded to Barney using FTP if there is a direct

connection (e.g., your computer is on ZagNet) or modem PPP connection (i.e., connecting via

Verio Northwest or other ISP) between your computer and Barney. If you are connecting over a

modem and are not using PPP, the file may be uploaded using a modem transfer protocol. For

more information on transferring files to Barney, see the section titled Downloading Files from
Barney using FTP or the handout Downloading Files from Barney using a Modem.

Accessing Student Web Pages from the World-Wide Web

Once you have placed your web pages on Barney and have set the access permissions correctly,

others may access your pages. The URL (Universal Resource Locator) for your default web

page is http://barney.gonzaga.edu/~youruserid. For example, if your userid was jdoe,  the

URL for your default page would be http://barney.gonzaga.edu/~jdoe. Your default page is named

index.html  and is located in your public_html  directory on Barney. Other pages can be

accessed directly by entering the name of the web page after your user id. For example,

http://barney.gonzaga.edu/~jdoe/resume.html would display the file resume.html  in your

public_html directory.

Creating HTML Documents

Web pages are commonly referred to as HTML documents because they use the HyperText

Markup Language (HTML) to provide formatting information. There are many programs that

can create HTML documents including Netscape Navigator 3.0 Gold, Netscape Communicator

4.0, Claris Home Page, Microsoft Office 97 (and earlier versions with free plug-ins from

Microsoft), and dozens of other programs. Since HTML documents are simply text documents

with special tags  to provide formatting information, they can also be created using text editors

and word processors. These include text editors on Barney such as pico, vi, and emacs. How you

create the documents is arbitrary and depends on your preferences. The web server on Barney

doesn t care which program created the web page as long as it is in the correct format.

There are dozens of books on creating web pages and many excellent tutorials and resources on

the Internet. A number of classes at Gonzaga also teach web page development.
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These options and more are available through LIBRIS: http://libris.gonzaga.edu

GONZAGA LIBRARY CATALOG

Searches for books, media, state and federal documents and titles of magazines and journals held in the Foley
Library.

ARTICLE INDEXES / DATABASES

§ ABI Inform – Indexes approximately 800 business, management, and trade journals. Some
articles may be available online as full text.

§ ATLA - Comprehensive index to periodicals, book reviews, scholarly essays, conference
proceedings, and books on religion and related fields.

§ Bio & Ag  - Index to periodicals in agriculture, biology, and related fields.

§ CINAHL - Comprehensive & authoritative index to current published literature in English for
nurses and other allied health professionals.

§ Compendex Engineering Index - Major index to engineering periodicals, conference
proceedings and related materials. Links through EIVillage.

§ ERIC (1966 to Present) - Index to journal articles and unpublished documents in the field of
education.

§ Find Law - A searchable directory of Internet legal resources.

§ ProQuest Direct - Provides access to summaries of articles from over 5,000 publications
including newspapers. Many articles also appear in full-text, full-image format. Available on
the GU campus network.

§ Psysch Info - Psychological abstracts from 1887 to the present.

§ PubMed - Access to Medline, the most comprehensive index to the world's medical literature,
and additional biomedical information resources.

§ Sociofile - Collection of citations and abstracts reflecting the world’s periodical literature in
sociology and related disciplines.

§ UnCover (1988 to Present) - UnCover is a database containing tables of contents of 10,000
plus recent journals.  Document delivery of articles located in UnCover is available for a fee.

http://libris.gonzaga.edu
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OTHER LIBRARY CATALOGS
        

§ Washington State and Spokane Area Libraries - Gonzaga Chastek Law Library,
Whitworth College, Spokane Public, Eastern Washington University, North Idaho College,
University of Washington, University of Idaho and other libraries.

§ Library of Congress

§ California Digital Library 

REFERENCE SOURCES AND GOVERNMENT PUBLICATIONS

• Books in Print

• Dictionaries:  Rhyming Dictionary, Roget’s Internet Thesaurus, WWWebster’s Dictionary
and others.

• Directories & Phone Books: AT&T 800 Directory, Canada411, Publishers, Association on
the Net and others.

• Encyclopedias:  Encyclopedia Britannica Online, Encyclopedia Smithsonian, The Catholic
Encyclopedia and others.

• Geography:  CIA World Factbook, The Embassy Page, World Flags, Country Studies and
others

• News:  CNN, MSNBC, Spokesman Review, UNCG’s News & Newspapers Online and others.

• Quotations: Bartlett’s Book of Familiar Quotations and  The Commonplace Book

• Style Manuals: Citing Electronic Resources, Elements of Style and Pitsco’s Launch to Citing
WWW Addresses

• Miscellaneous: Nobel Prizes and Statistical Abstract of the United States.

YOUR LIBRARY RECORD

Enter your library card number (found on the your GU ID card, not your social security number)
and view your library record: items checked out, overdue, on hold and fines. You can even renew
books you have checked out.

INTERLIBRARY LOAN

If you need a book or article that is not located at the Foley Library, you can request to have them
sent to you from another library. Request forms for interlibrary loan of books or articles can be
found at http://www.foley.gonzaga.edu/ill/index.html. This process can take one to two weeks and is
free to Gonzaga students.

http://www.foley.gonzaga.edu/ill/index.html
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GU Catalog Searching Tips

SEARCH BASIC COMMANDS

 KEYWORD Use when you are:

• Looking for a particular subject
Example:  gonzaga university

• Unsure of the exact wording of a title (keyword search)
  Example:  gone wind

 AUTHOR OR
NAME

Use when you are:

• Looking for something BY OR ABOUT  a person
Example:  crosby bing or bing crosby

• Looking for something BY or ABOUT  an organization
Example:  central intelligence agency

TITLE
BROWSE

Use when you are:

• Searching the EXACT title of a book, journal or magazine
  Example:  adventures of huckleberry fin
                    journal of higher education

SUBJECT
BROWSE

Use when you are:

• Searching the EXACT subject heading of a book, journal or magazine
 Example: art, modern

BROWSE
 CALL #

Use when you are:

• Interested in browsing a CALL NUMBER SECTION
Example:  hv1400

Assistance is available from the Foley Library Reference Desk 323-5931

If you need any help with your research through out the year,
Please ask the Reference Desk or call x5931



Gonzaga University Computer Labs - Fall 2000

Bldg Room Normal Hours (1) Type Software Print(3) Restrictions Contact

Admin 243 24 Hours WinNT MS Office 97 Pro(2), WordPerfect 8.0, Internet Explorer DotMat Lab closed occasionally for classes Vicki Craigen (x5552)

Mac MS Office 98(2), ClarisWorks 4.0, Internet Explorer Laser

Admin 134 TBA Win98 MS Office 97 Pro(2), WordPerfect 8, Netscape Laser Lab hours dependent upon tutor availability Donna Campbell (x6676)

Admin 425 TBA Mac MS Office 98(2), Netscape,  Desktop Publishing Laser Comm Arts students have 24 hr access John Caputo (x6656)

Foley ISM M-Th 8a-8p Win95 MS Office 97 Pro(2), Internet Explorer DotMat Open during library hours Matt Wood (x3861)

F 8a-5p, Sat 10a-4p Mac MS Office 98(2), Clarisworks, Internet Explorer Laser

Sun 1p-5p

Herak 220 TBA Various Dynamic configuration to meet class needs Laser Access limited to certain classes Brett Hendricks (x3910)

Herak 223 TBA WinNT MS Office 97(2), Netscape, Visual Studio 6.0 DotMat Lab hours dependent upon workstudy avail Brett Hendricks (x3910)

InkJet Must have a lab account

Herak 103/104 M-F 8a-10p WinNT MS Office 2000, MS Project, AutoCAD, Visio Express, Laser Engineering students only Roger Melvin (x6819)

Netscape, Internet Explorer, MathCAD, Matlab, Ansys, Color Engineering students have 24 hr access

and other Engineering Applications Plotter

Hughes 137 M-F 8a-5p Mac Biology software Laser Biology classes and students only Sherry Woods (x6626)

Jepson 07 M-Th 9a-10p WinNT MS Office Pro(2), Netscape, Internet Explorer Laser Lab closed occasionally for lectures Bob Toshack (x3407)

F 9a-5p, Sat 12p-5p Win95 MS Project, Borland C++, Microsoft Visual C++ 6.0 Color

Sun 2p-10p

Music Office hours Win98 MS Office 97(2), Netscape, Music Composition Laser Music students only Music Office (x6733)

Mac MS Office 98(2), Netscape, Music Composition

Rosauer 101 M-Th 8a-9p Mac MS Office 98(2), ClarisWorks, Internet Explorer, SPSS Laser Educational students have priority Jason Gilman (x3660)

F 8a-6p, Sun 6p-10p Win95 Netscape, PageMaker, Photoshop, educ. software

(1) Hours of computer labs subject to change.
(2) MS Office includes Word, Excel, PowerPoint. MS Office Pro also includes Access database software.
(3) Some computer labs charge for printing to laser or color printers. Contact that lab for details.

Page 42 Rev 8/16/00
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UNIX Quick Reference
The following are commonly used commands on UNIX systems. This include Barney, Chaos,
and the Sun workstations in the Computer Science Lab. The commands on Chaos and the Sun
workstations may differ slightly from these commands.

The following format is used for commands:

Italic indicates a variable that you supply
Bold indicates typed exactly as shown

alias
Creates a temporary name for a UNIX command.

alias name='command'
To remove an alias:

unalias name

apropos
Display a list of man pages containing keyword.

apropos keyword

archie
Searches Internet ftp sites for the specified file name.

archie file

cal
Display a calendar for the current month.

cal
To display a calendar for the specified year:

cal year

cat
Displays the contents of a text file.

cat file

cd
Changes current directory to a different directory.

cd directory
To change to you home directory

cd
Directory abbreviations

~ Home directory
. Current (working) directory
.. Parent Directory

chmod
Changes permission status for a file or directory.

chmod code file
To keep a file private (default for new files)

chmod 600 file
To give everyone read permission

chmod 644 file

compress
Reduces the size of a file and adds a .Z to the file name.

compress file
To restore a compressed file:

uncompress file.Z

cp
Makes a copy of a file.

cp file newfile
To copy a file into a different directory:

cp file directory
To inquire before overwriting an existing file:

cp -i file newfile

diff
Compares two files and compares the differences.

diff file1 file2

exit
Ends your computer session.

finger
Displays user information at the specified host (computer).

finger userid@host
For information on people located on Barney

finger userid

forward
To forward your mail to another account.

forward userid@host
To stop the forwarding of mail:

forward none

ftp
Starts the file transfer program with a remote computer.

ftp address

grep
Finds lines in a file matching the specified character pattern.

grep -cin pattern file
-c Lists a count of the lines that matched the pattern
-i Ignores case
-n Lists line number for each line

head
Displays the first ten lines of a file.

head file
To display the first n number of lines of a file:

head -n file

jobs
Displays active jobs and their corresponding job numbers.

jobs
To start a job in the background:

job &
To return a job to the foreground:

fg %jobnumber
To send a running job to the background:

<Control>z bg
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kill
Terminates a process by its process identification number (pid).

kill pid
Strongest form of kill:

kill -9 pid

lp
Print a file to the default printer.

lp file
To print a job to a specific printer.

lp -d printername file

ls
Lists the files and subdirectories in the current directory.

ls -ltad  filter
-l Lists long format (same as ll)
-t Lists sorted by modification time
-a Lists all files including files beginning with a dot (.)
-d Suppresses the listing of the contents of a subdirectory

lynx
Runs the text-based web browser.

lynx url

mailid
Shows accounts with keyword in the user's e-mail address.

mailid keyword

man
Display the manual page for the specified command.

man command

mesg
Deny or allow access for other users to write to your account.

mesg -y Allow users to write to your account.
mesg -n Deny users ability to write to your account.

mkdir
Creates a new directory within the current directory.

mkdir directory

more
Displays the contents of a file one screen at a time.

more file
Use <spacebar> to scroll forward and q to quit.

mv
Moves a file or directory to a different directory.

mv file directory
Renames a file or directory:

mv oldfilename newfilename
To inquire before overwriting an existing file:

mv -i oldfilename newfilename

news
Display unread announcements.

passwd
Changes account password.

pico
Starts the Pico text editor.

pine
Starts the Pine electronic mail program.

ps
Displays process information for processes created by you.

pwd
Display the absolute pathname of the current directory.

rm
Permanently deletes a file.

rm file
To confirm prior to deleting file:

rm -i file
To recursively delete a directory:

rm -r directory

rmdir
Deletes an empty directory.

rmdir directory
To confirm prior to deleting directory:

rmdir -i directory

spell
Checks the spelling of the contents of a file.

spell file

tail
Displays the last ten lines of a file.

tail file
To display the last n number of lines of a file:

tail -n file

telnet
Starts a telnet session with a remote computer.

telnet address

tin
Starts threaded Usenet news reader.

vi
Starts the vi text editor with a file.

vi file

w
Displays a list of who is logged onto Barney.

wc
Counts lines, words, and characters in a file.

wc file

xmodem
Transfer a file via modem (non-PPP)

xmodem -rstb file
-r Receive a file (fm local computer to server)
-s Send a file (fm server to local computer)
-t Transfer a text file
-b Transfer a binary file

ytalk
Talk with another user that is logged onto a computer.

ytalk username@host
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Purchasing a Computer
If you are planning on purchasing a computer, you may want to take a couple of things into

consideration before making the purchase. This handout doesn t attempt to offer any definite

answers but it may be useful when making a purchasing decision. Keep in mind that the

information contained in this document was written in August of 2000. The computer market

changes so rapidly that the information that was valid when this document was written may not

apply today.

Considerations

There are a number of things to keep in mind when purchasing a computer. These include what

field you are entering, whether or not you will be working on a network, what type of work you

will be doing on the computer, and how often you can afford to replace the computer. You

should also take into consideration the entertainment side of computers since many personal

computers that are purchased for business purposes are also used to play games.

Who to Ask

You might think that the logical answer would be one of the computer gurus down the hall, a

computer support person at Gonzaga, or a salesperson at a computer store. While they may give

you an abundance of technical details about computers, they may not necessarily know your

needs. The best source of information can be from those people that are working in the same

field; they often have experience in areas you ll be working and they may have gone through the

same ordeal themselves. Professors can also be a good source of information; they should know

the current needs of their field and should be able to give you some good pointers. You might also

try local user groups; the people that often attend user group meetings are new computer owners

from all walks of life. Other sources of information include computer magazines, trade journals,

and the Internet.

The most important thing to consider when asking others for their recommendations is to back

up their information with information from other sources. This is especially true when looking at

a particular computer vendor. You should check on the company s technical support ratings,

satisfaction ratings, whether or not they have toll free technical support, etc. Purchasing a

computer is a major expense and should be evaluated seriously before making a purchase.

Purchasing through Gonzaga University

Students are able to purchase some brands of computers through the campus at reduced pricing.

Apple Macintosh and several brands of PCs are available at educational discounts through

Purchasing. For more information on purchasing through Gonzaga, call Purchasing at 323-5672.
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Software

There are thousands of software packages available for both the PC and Macintosh platforms.

The software that will be most commonly used will be word processors, Internet software,

presentation programs, and spreadsheets. Most of Gonzaga has standardized on Microsoft

Office for word processing (Word), spreadsheets (Excel), and presentations (PowerPoint). If you

choose to use a different package, try to select one that is able to read documents created by

Microsoft Office products. Microsoft Office is available in the campus bookstore.

Typical Configuration for Students

The following are typical configurations available in August 2000. They are meant to be used as a

baseline for making a purchasing decision. These systems will not meet the needs of everyone.

PC w/Windows 95/98

Minimum Recommended

Processor: Intel Celeron 600 MHz Pentium III 700 MHz

Memory: 64 MB RAM 96 MB RAM

Hard Disk: 4.3 GB 6.4 GB

CD-ROM: 40x DVD

Monitor: 15  SVGA 17  SVGA

Modem*: 56 kbps v.90 56 kbps v.90

Sound: 16-bit SoundBlaster 32-bit SoundBlaster

Network**: SMC 9432TX SMC 9432TX

Macintosh

Minimum Recommended

Processor: iMac or G3 PowerMac iMac 333 or G4 PowerMac

Memory: 64 MB RAM 96 MB RAM

Hard Disk: 4.0 GB 6.4 GB

CD-ROM: Standard Speed DVD

Monitor: 15  Color 17  Color

Modem*: 56 kbps v.90 56 kbps v.90

Sound: Built-in Built-in

Network**: Built-in Built-in

*Most consumer computer models come with either a modem or no communication device. In order to use ZagNet,

you will need to purchase a 10BaseT Ethernet card separately (see note below). Some manufacturers either include

an Ethernet card or include it as an option. Apple includes Ethernet with all new Macintosh computers.

**To access ZagNet, you must have an Ethernet card. Gonzaga will support only SMC (PC) and Apple or Asant

(Mac) 10BaseT Ethernet cards. If you are not planning to connect to ZagNet or other network, then an Ethernet card

is not necessary.



Internet Worksheet Page 47

Internet Worksheet
Introduction

Every computer connected to ZagNet requires certain address information that will uniquely
identify it to the network and will allow it to communicate with other computers on the Gonzaga
campus and the Internet. The following worksheet will determine the values for your computer.

Basic Configuration Information

The following information is required in order for your Internet connection to work properly:

IP Address: 147.222.______.______  (e.g., 147.222.131.125)

The IP address is the unique identifier for your computer. It is
a series of four numbers separated by periods. The periods are
required whenever using an IP address. All IP addresses on
campus begin with “147.222.”. For residence halls, the third
number specifies the residence hall (see back of this form) and
the fourth number is the specific port number in the residence
hall. The port number is written on the wall jack where you
connect the network cable.

Router/Gateway Address: 147.222.______.254  (e.g., 147.222.131.254)

The router/gateway address is unique for each residence hall.
Only the third number of the four is different depending upon
the residence hall. The router/gateway addresses for each of the
residence halls is on the back of this form.

The following information is the same for each of the residence halls:

Subnet Mask: 255.255.255.0

This is also known as a “Class C” address.

DNS/Name Server Address: 147.222.1.253
 Backup DNS Server: 147.222.2.253

Search Domain: gonzaga.edu

Additional Information

The following information is used by various Internet applications such as e-mail clients, Usenet
news clients, etc.

SMTP/POP Server: barney.gonzaga.edu
NNTP/News Server: news.gonzaga.edu

LDAP Directory Server: whitepages.gonzaga.edu
Web Server*: http://barney.gonzaga.edu

*This is the web server where student web pages are located. The official Gonzaga web server is
http://www.gonzaga.edu.
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ZagNet Information for Residence Halls

Location Address Group Gateway Address Subnet Address
301 Boone 147.222.131.xxx 147.222.131.254 255.255.255.0
801 Boone 147.222.132.xxx 147.222.132.254 255.255.255.0
Alliance 147.222.133.xxx 147.222.133.254 255.255.255.0
Burch 147.222.134.xxx 147.222.134.254 255.255.255.0
Campion 147.222.135.xxx 147.222.135.254 255.255.255.0
Crimont 147.222.136.xxx 147.222.136.254 255.255.255.0
Cushing 147.222.137.xxx 147.222.137.254 255.255.255.0
Desmet 147.222.138.xxx 147.222.138.254 255.255.255.0
Dooley 147.222.139.xxx 147.222.139.254 255.255.255.0
Dussault 147.222.140.xxx 147.222.140.254 255.255.255.0
Lincoln 147.222.141.xxx 147.222.141.254 255.255.255.0
Madonna 147.222.142.xxx 147.222.142.254 255.255.255.0
Rebmann 147.222.143.xxx 147.222.143.254 255.255.255.0
Roncalli 147.222.144.xxx 147.222.144.254 255.255.255.0
St. Catherine 147.222.145.xxx 147.222.145.254 255.255.255.0
St. Monica 147.222.146.xxx 147.222.146.254 255.255.255.0
Sharp Apt/House 147.222.147.xxx 147.222.147.254 255.255.255.0
Welch 147.222.148.xxx 147.222.148.254 255.255.255.0
Chardin 147.222.149.xxx 147.222.149.254 255.255.255.0
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Network and Computer Resource
Acceptable Use Policy

Section 1: Introduction

{a} This policy is established to make users of Gonzaga University s computing resources aware of their privileges and responsibilities.

{b} This policy is established to maximize the value of those resources to the university community while permitting maximum
freedom of use consistent with law, the University s mission statement, the Student Handbook, the Personnel Policies and
Procedures Manual, the Faculty Handbook, and a productive environment. Any use of Gonzaga University computing resources
which violates policies contained in these manuals and handbooks also violates this policy; nothing in this policy shall contradict
existing University policy.

{c} Violation of this policy can result in reprimand, reduction or loss of computing privileges, and/or referral to University authorities
for disciplinary action. Violation of law may result in referral to appropriate authorities.

{d} This policy provides general guidelines regarding the use of GUnet. Refer to http://www.gonzaga.edu/tech/aup/ for specific
examples of acceptable and unacceptable uses of GUnet as defined by this policy.

Section 2: Definitions

{a} GUnet -- the physical network media and the attached computers and software owned or controlled by the University. GUnet
includes ZagNet, the student network connecting the residence halls to the campus network.

{b} Internet -- the global computer network composed of millions of computers and thousands of networks.

{c} Logged on -- connected to a service with a non-public user identification (e.g., personal account).

{d} Resource -- any computing device, peripheral, software, or related consumable (e.g., paper, disk space, central processor time,
network bandwidth) owned or controlled by the University.

{e} Service -- any software that makes a computer s files or other locally stored information available for use by another computer or
facilitates the transfer of data between two remote computers. Services include, but are not limited to, web, file, and e-mail server
software.

{f} Spam  -- unsolicited mass e-mail for the purpose of advertising a service, personal gain, or other inappropriate use.

Section 3: General Usage Statement

{a} Network and computing resources at the University are provided primarily to support the mission of the University. Users may
occasionally use GUnet for personal needs as long as such use is consonant with established University policy and does not inhibit
academic or administrative use of GUnet.

{b} The University cannot provide, and will not be responsible for, software kept on personally owned computers, nor are they
responsible for the installation, repair, maintenance or upgrade of personally owned hardware.

{c} Users should not leave a computer logged on if the user will be away from the computer for an extended period of time (e.g., two
hours) or the computer is in an unsecured area. Data on local hard drives should be secured either through password protection or
physical security (e.g., locked office) when the user is not present.

{d} Personal accounts are private and should not be shared with others.

{e} The use of University resources, including GUnet, for political gain or exclusive personal gain shall not be permitted.
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{f} The University may restrict the use of computing and network resources. This includes blocking spam messages and deleting user
files and mail to conserve disk space on University owned computers.

{g} Employees, students, and other authorized users may post electronic documents and images (e.g. web pages) for public access
provided that those documents conform to policies contained within the documents listed in Section 1{b} and United States and
international copyright law.

Section 4: Unacceptable Uses

{a} Using GUnet for any unlawful activity.

{b} Sending spam or creating or retransmitting chain e-mail messages.

{c} Sending e-mail from another user s account.

{d} Altering the header of an e-mail message to prevent the recipient from determining the actual sender of the e-mail.

{e} Logging into or using any computer account or accessing, modifying, or creating any files without the account owner s permission.

{f} Introducing new services or resources (e.g., personal web server) or altering existing services or resources (e.g., registering personal
domain name) on GUnet without the approval of Information Technology Services.

{g} Transmitting, without authorization, information proprietary to the University or information that could be construed as a statement
of official University policy, position, or attitude.

{h} Distributing information encouraging the patronage of network sites containing material prohibited by policies contained within the
documents listed in Section 1{b}.

{i} Wasting resources such as print services, disk space, and network bandwidth.

{j} Intercepting network traffic without authorization.

{k} Using GUnet for any activity that results in degradation of University provided services, denies services to other GUnet users, or
jeopardizes the security or capabilities of GUnet.

Section 5: Privacy

{a} Under ordinary and normal circumstances, a user s computer files -- including electronic mail -- are considered private. In order to
correct system problems or investigate misuse of resources, it may be necessary for system administrators to examine users  files
(including e-mail and network traffic). In such cases, user privacy will be respected to the extent possible consistent with University
policy and the law.

{b} Personal web pages and e-mail addresses may be listed on University directories unless the user specifically requests that this
information be kept confidential.

Section 6: Agreement

{a} I understand that access to GUnet is a privilege and not a right. I acknowledge that failure to conform to this policy statement may
result in revocation of my GUnet account(s) and/or network access. Furthermore, disciplinary action consistent with University
policy may be taken by the appropriate University officers (e.g., Student Life, Department Chair, supervisor) and illegal activities
may be referred to the appropriate authorities.

{b} I understand the above stated conditions for accessing GUnet and the Internet, and I agree to abide by these terms and conditions. I
understand that certain material found on the Internet is offensive to some people and that I access the Internet of my own free
will. Furthermore, I request access to Gonzaga University computing resources and/or an account on GUnet.

_________________________________________________________________________________________________________

Name of user (printed)

_________________________________________________________________________________________________________

Signature of user Date


